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 கற்றலின் ந�ோக்கங்கள்
இந்தப் பாடப்பகுதியைக் கற்றபின் மாணவர் அறிந்து க�ொள்வது.
●	 மின்னணு தரவு பரிமாற்றம் (EDI) இல் அடிப்படை அறிவை பெறுதல்
●	 EDI வரலாற்றை மேல�ோட்டமாக அறிந்துக்கொள்ளுதல்
●	 EDI வகைகளைப் புரிந்துக�ொள்ளுதல்
●	 EDI நன்மைகள் தெரிந்துக�ொள்ளுதல்
●	 EDI அடுக்குகளைப் பற்றி அறிந்துக�ொள்ளுதல்
●	 EDI நியமங்களை புரிந்துக�ொள்ளுதல்
●	 un/edifact பற்றி சுருக்கமாக அறிதல்

18.1  அறிமுகம்
கணிப்பொறிகளின் வளர்ச்சி 
த�ொடங்கியதும், பல நிறுவனங்கள் 
தரவுகளை சேமித்து, செயல்படுத்த 
கணினிகளைப் பயன்படுத்த 
த�ொடங்கின. இருப்பினும் வெவ்வேறு 
நிறுவனங்கள் வெவ்வேறான பயன்பாட்டு 
முறைமைகளை பயன்படுத்தியதால், 
உருவாக்கப்படும் தரவுகளின் வடிவமைப்பு 
ஒரே மாதிரியாக இல்லை. நிறுவனங்கள் 
தங்கள் வணிகத் தேவைகளுக்கு த�ொடர்பு 
க�ொள்ள வேண்டிய அவசியம் ஏற்பட்டால், 
அவை மீண்டும் தரவுகளை மாற்றி 
உள்ளிட (Rekey) வேண்டியிருந்தது. இதன் 
காரணமாக உண்டான நேர விரயம் 
வியாபார நடவடிக்கைகளில் பெரும் 
தடையாக இருந்தது. இப்பிரச்னைக்கு 

தீர்வு காண, சில நிறுவனங்கள், குறிப்பிட்ட 
செந்தர வடிவமைப்பை பயன்படுத்தத் 
த�ொடங்கின. இதனை EDI ன் த�ோற்றமாக 
கருத முடியும்.

விரைவிலேயே, நிறுவனங்கள் 
EDI உபய�ோகத்தின் மதிப்பை உணரத் 
த�ொடங்கின. நிறுவனங்கள் EDI 
பயன்படுத்துவது அவர்களின் த�ொழிலுக்கு 
உதவும் என்றும், லாபம் பெருகும் என்றும் 
நம்பினர். இந்த தரநிலைகள் விரைவாகவும் 
குறைந்த விலையிலும் க�ொள்முதல் ஆணை 
(Order) கொடுக்க மற்றும் பொருட்களை 
விநியோகிக்க வழிவகை செய்தது. 
ஆவணங்கள் ரேடிய�ோ, த�ொலை-அச்சு, 
டெலக்ஸ்-செய்திகள் அல்லது த�ொலைபேசி 
மூலமாக  மின்னணு முறையில் பரிமாற்றம் 
செய்யபட்டன. 

18பாடம்

மின்னணு தரவு பரிமாற்றம்
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விற்பனையாளர்களுக்கும், வர்த்தகக் 
கூட்டாளிகளுக்கும் மட்டும் அல்லாமல் 
ஒரே நிறுவனத்தின் பல துறைகளுக்கு 
இடையே தரவு பரிமாற்றத்தையும் 
உள்ளடக்கியது. EDIFACT, ANSI-ASC X12 
ப�ோன்றவை சர்வதேச அளவில் ஏற்கப்படும் 
EDI தரநிலைகள் ஆகும். 

1977 ல், பல்பொருள் அங்காடி 
நிறுவனங்கள் மற்றும் அவற்றின் வணிக 

EDI மூலம்"காகிதமற்ற வணிகம்" 
மற்றும் EFT மூலம் "காகிதமற்ற நிதி 
பரிமாற்றம்" சாத்தியமாகிறது.

மின்னணு தரவு பரிமாற்றம்
மின்னணு தரவு பரிமாற்றம் (Electronic 
Data Interchange - EDI) என்பது வர்த்தக 
நிறுவனங்களுக்கு  இடையே மின்னணு 
வணிக ஆவணங்களை பரிமாற்றம் 
செய்வதை குறிக்கும். இது ஒரு தனிப்பயன் 
தடம் (Dedicated Channel) மூலமாகவ�ோ 
அல்லது இணையம் மூலமாகவ�ோ 
முன் வரையறுக்கப்பட்ட வடிவத்தில், 
அதிக மனித தலையீடு இல்லாமல் 
நடைபெறுகிறது.

EDI விநிய�ோக குறிப்புகள், 
விலைப்பட்டியல்கள், கொள்முதல் 
ஆணைகள், செயல்பாட்டு ஒப்புகைகள் 
ப�ோன்ற ஆவணங்களை பரிமாற்றம் 
செய்ய பயன்படுத்தப்படுகிறது. வழங்கல் 
நிறுவனத்தின் கணினியில் இருந்து இந்த 
ஆவணங்கள் நேரடியாக அனுப்பப்படும். 
இதனால் பாரம்பரிய  "காகித" த�ொடர்பில் 
நேரும் பல பிழைகளை தவிர்த்து, 
பெரும் நேரம் மற்றும் ப�ொருட் செலவு 
குறைக்கப்படும்.

இணையம் சார்ந்த மின்-வணிகம் 
பிரபலபமாவதற்கு முன்பு, மின்னணு தரவு 
பரிமாற்றம், த�ொழில் நிறுவனங்களுக்கு 
இடையே பெரும் வரவேற்பைப் 
பெற்றிருந்தது. மின்னணு தரவு பரிமாற்றம் 
ஒரு நிறுவனத்தின், வாங்குபவர்களுக்கும் 

படம்: 18.1  மின்னணு ஆவண பரிமாற்றம்

EDI வரலாறு

1960 களின் பிற்பகுதியில், 
அமெரிக்காவின் கப்பல், இரயில், விமான 
ப�ோக்குவரத்து நிறுவனங்கள் மற்றும் 
சரக்குந்து (Truck) நிறுவனங்கள் 
தங்கள் வணிகங்களுக்காக மின்னணு 
செய்திகளை பரிமாறிக் க�ொண்டிருந்தன. 
இந்த செய்திகள் வெவ்வேறு 
வடிவங்களில் இருந்தன, அதனால் 
ப�ொருட்கள் பரிமாற்றம் செய்வதில் 
சிக்கல்கள் ஏற்பட்டது. 1968 ல் இந்த 
நிறுவனங்கள் தங்களுக்குள் ஒன்றாக 
இணைந்து Transportation Data 
Coordinating Committee (TDCC) என்ற 
குழுவை அமைத்து EDI தரநிலைகளை 
உருவாக்க துவங்கின. 1975 ல் 
இக்குழுவால் வெளியிடப்பட்ட TDCC 
தரநிலை முதல் குறிப்பிட்ட த�ொழில்துறை 
EDI ஆகும். இதில் எட் கில்பர்ட் முக்கிய 
பங்களிப்பாளராக இருந்தார். பின்னர் 
மற்ற த�ொழில்களும் தங்கள் தனிப்பட்ட 
தேவைகள் அடிப்படையில் பல 
தரப்பாடுகளை உருவாக்க த�ொடங்கின.
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என்னும் ஒருங்கிணைந்த EDI தரப்பாடுகளை 
உருவாக்கி பயன்படுத்தி வந்தது.

ANSI X12 மற்றும் GTDI 
ஆகியவை முறையே வட அமெரிக்கா 
மற்றும் ஐர�ோப்பாவின் பிராந்திய EDI 
தரப்பாடுகளாக பயன்படுத்தப்பட்டு வந்தன. 
சில ஆண்டு ச�ோதனைக்கு பின்னர் இரண்டு 
தரநிலைகளும் ஒருங்கிணைந்து ப�ொது 
தரநிலைகளைகளுக்கான ஆராய்ச்சியை 
நடத்த த�ொடங்கின. சர்வதேச வர்த்தகத்தை 
எளிமைப்படுத்துவது த�ொடர்பாக (UN/ECE/
WP.4) EDI தரநிலைகளை மேம்படுத்தும் 
பணியை செய்தது. இதைத் த�ொடர்ந்து, 
1985 இல், ஐக்கிய நாடுகள் சபை, மின்-
வணிக த�ொழில்நுட்பம் உலகளவில் 
த�ொழில் துறைக்கு உதவ UN/EDIFACT 
யை உருவாக்கியது. EDIFACT பெரிதும் 
பயன்படுத்தப்படும் EDI தரநிலை ஆகும்.

முதல் EDI செய்தி, 1965 இல், 
ஹாலந்து-அமெரிக்க நீராவி 
கப்பல் நிறுவனத்திலிருந்து 

ட்ரான்ஸ்-அட்லாண்டிக் கப்பல் 
நிறுவனத்திற்கு டெலெக்ஸ் செய்திகளைப் 
பயன்படுத்தி அனுப்பப்பட்டது. கணினி ஒரு 
முழு பக்கத்தை கிட்டத்தட்ட 2 நிமிடங்களில் 
அனுப்பியிருந்தது. இந்த செய்திகளை காந்த 
நாடாக்களில் எழுதி பின்னர் மற்றொரு 
கணினியில் பயன்படுத்த முடியும்.

18.2  EDI வகைகள்
தகவல் த�ொடர்பு இணைப்புகள் மற்றும் 
பரிமாற்ற ஊடகத்தின் EDI கீழ்கண்டவாறு 
வகைப்படுதலாம். 
●	 நேரடி EDI
●	 VAN வழியாக EDI
●	 FTP/VPN, SFTP, FTPS வழியாக EDI
●	 இணையம் வழி EDI
●	 கைப்பேசி வழி EDI

கூட்டாளிகளின் ஒரு குழு, EDI தரப்பாடுகளை 
வரையறுத்து பயன்படுத்த த�ொடங்கின. 1978 
ல் TDCC நிறுவனம் Electronic Data Interchange 
Association - EDIA) என பெயர் மாற்றம் 
செய்யப்பட்டது. அதன் பின்னர் அந்த ஆண்டில், 
அமெரிக்க தேசிய தர நிர்ணய நிறுவனம் 
EDIA க்கு ப�ொறுப்பேற்று, American National 
Standards Institute - Accredited Standards 
Committee (ANSI-ASC) என்றானது. இக்குழு 
ANSI X12 என்னும் தரநிலையை உருவாக்கி 
வெளியிட்டது.

மறுபுறம், ஐர�ோப்பிய பிராந்தியமும் 
Guidelines for Trade Data Interchange (GTDI) 

ஏனைய பல தகவல் 
த�ொழில்நுட்பங்களைப் ப�ோலவே, 
EDI யும் பாதுகாப்பு மற்றும் 

ஆராய்ச்சி நிறுவனத்தின் மேம்பாடுகளால் 
தூண்டபட்டு உருவாக்கப்பட்டது. 
எட் கில்பர்ட், EDI யின் தந்தை என்று 
அழைக்கப்படுகிறார். இவர் தனது குழுவுடன் 
இணைந்து 1948 பெர்லின் விமான 
சரக்கு-ப�ோக்குவரத்து பணியின்போது 
வணிக ஆவண பரிமாற்றத்திற்கான 
முதல் தரப்படுத்தப்பட்ட (856, மற்றும் ANS 
ப�ோன்ற) வடிவமைப்பை  உருவாக்கினார். 
பிற்காலத்தில் அது ஒரு கணினியில் 
இருந்து மற்றொரு கணினிக்கு எவ்வாறு 
ஆவணங்கள் அனுப்பப்படுகிறது என்பதில் 
தாக்கம் செலுத்தியது. இந்த தரநிலை, 
ம�ொழி தடையில்லாமலும் தாமதப்படுத்தும் 
குழப்பமான வடிவங்கள் இல்லாமலும் 
"அனுப்புகையில் என்ன அடங்கியிருந்தது", 
“சரக்குகளை வழங்குபவர் யார்", 
ப�ோன்றவற்றை கண்காணிக்க உதவியது. 
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இணைய வழி EDI
இணைய அடிப்படையிலான EDI, 
இணையம் வழியாக ஒரு உலாவியை 
பயன்படுத்தி நடைபெறுகிறது. இங்கு 
நிறுவனங்கள் ஒரு உலாவியைப் 
பயன்படுத்தி தரவை தங்கள் வர்த்தகக் 
கூட்டாளிகளுக்கு பரிமாற்றம் செய்கின்றன. 
சிறிய மற்றும் நடுத்தர நிறுவனங்களுக்கு 
ஏற்ற எளிமையையும் மற்றும் வசதியையும் 
க�ொண்டது இணைய EDI ஆகும்.

கைப்பேசி வழி EDI 
திறன்பேசி அல்லது பிற கையடக்க 
சாதனங்களை EDI ஆவணங்களை 

நேரடி EDI
இது முனையம்-முனையம் EDI (Point-
to-Point) என்றும் அழைக்கப்படுகிறது. 
இது பல்வேறு வணிக கூட்டாளிகளுக்கும் 
இடையே நேரடி த�ொடர்பை 
ஏற்படுத்துகிறது. இந்த வகை EDI, த�ொடர் 
வணிக பரிவர்த்தனைகளுக்கும் பெரிய 
நிறுவனங்களுக்கு ப�ொருந்தும்.

VAN வழியாக EDI
இது மதிப்புக் கூட்டப்பட்ட வலையமைப்பு 
வழியாக நடைபெறும் EDI ஆகும். இங்கு 
EDI ஆவணங்கள் மூன்றாம் தரப்பு (Third 
Party) வலை சேவை வழங்குநர்களின் 
ஆதரவுடன் பரிமாற்றம் செய்யப்படுகின்றன. 
பல நிறுவனங்கள் வலையமைப்பு 
த�ொழில்நுட்பங்களின் புதுப்பித்தல் ப�ோன்ற 
சிக்கல்களை தவிர்க்க இந்த வகையை 
விரும்புகின்றன.

FTP/VPN, SFTP, FTPS வழியாக EDI
FTP/VPN, SFTP மற்றும் FTPS ப�ோன்ற 
நெறிமுறைகளை பயன்படுத்தி இணையம் 
அல்லது அகஇணையம் அடிப்படையில் 
EDI ஆவணங்களை பரிமாற்றம் செய்வது 
ப�ொதுவாக FTP/VPN, SFTP, FTPS வழியாக 
EDI என அழைக்கப்படுகிறது. 

படம் 18.2  EDI வான் வழியாக

மதிப்பு கூட்டப்பட்ட 
வலையமைப்பு என்பது ஒரு 
நிறுவனம் அதன் ச�ொந்த 

வலையமைப்பை அடிப்படையாக 
க�ொண்டு மற்ற நிறுவனங்களுக்கு EDI 
சேவைகளை வழங்குவதை குறிக்கிறது. 
இது வணிகர்களுக்கிடையே ஒரு 
இடைத்தரகர் ப�ோல் செயல்படுகிறது. 
மதிப்பு கூட்டப்பட்ட வலையமைப்புகளின் 
க�ோட்பாடுகள் அணுகல் உரிமைகளை 
பயனர்களுக்கு ஒதுக்கீடு மற்றும் உயர் 
தரவுப்பாதுகாப்பு வழங்தல் ஆகும். 
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இந்த EDI அடுக்குகள் ஒரு 
கணினியில் இருந்து மற்றொரு 
கணினிக்கு தரவு எவ்வாறு பாய்கிறது 
என்பதை விவரிக்கிறது.

EDI Semantie
layer Application level services

EDIFACT business form standards

ANSI X 12 business form standards

Electronic mail X.435, MIME

FTP. TELNET

HTTP

Point to point

World Wide Web

Dial-up line, internet, I-way

EDI standard 
translation layer

EDI Transport
layer

Physical layer

படம்: 18.3  EDI அடுக்குகள்

18.5  EDI உறுப்புகள் (Components)
EDI ல் நான்கு முக்கிய உறுப்புகள் உள்ளன. 
அவை

1.	 Standard document format
2.	 Translator and Mapper 
3.	 Communication software 
4.	 Communication network

18.6  EDI தரப்பாடுகள் (Standards)
தரநிலை என்பது ஒட்டும�ொத்த EDI ல் 
மிக முக்கியமான பகுதியாகும். EDI தரவு 
பரிமாற்றம் என்பது ஒரு ஒப்புக்கொண்ட 
செய்தி வடிவமைப்பின் வடிவத்தில் 
இருப்பதால், ஒரு ஒருங்கிணைந்த EDI 
தரத்தை உருவாக்குவது முக்கியமானதாக 
கருதப்படுகிறது. EDI தரநிலை முக்கியமாக 
பின்வரும் அம்சங்களாக பிரிக்கப்பட்டுள்ளது: 
அடிப்படை தரநிலைகள், குறியீடு 
தரநிலைகள், செய்தி தரநிலைகள், ஆவண 
தரநிலைகள், மேலாண்மை தரநிலைகள், 
பயன்பாட்டு தரநிலைகள், தகவல் த�ொடர்பு 
தரங்கள் மற்றும் பாதுகாப்பு தரநிலைகள்.  

முதல் த�ொழில் சார்ந்த EDI தரநிலை 
1975 ஆம் ஆண்டில் ப�ோக்குவரத்து தரவு 
ஒருங்கிணைப்புக் குழுவால் வெளியிடப்பட்ட 

பரிமாற்றம் செய்ய பயன்படுத்தப்படும்போது 
அது கைப்பேசி வழி EDI எனப்படுகிறது. 
கைப்பேசி வழி EDI பயன்பாடுகள், EDI 
பரிமாற்றங்களின் வேகத்தை கணிசமாக 
அதிகரிக்கிறது.

18.3  EDI நன்மைகள்
காகித அடிப்படையிலான பரிமாற்ற 
செயலாக்கம் மற்றும் பிற மின்னணு 
தரவு பரிமாற்றத்தின் உள்ளார்ந்த 
பிரச்சினைகளை தீர்க்க EDI 
உருவாக்கப்பட்டது. EDI  அமைப்பை 
செயல்படுத்துதல் மூலம் ஒரு நிறுவனம் 
அதன் விநிய�ோக த�ொடர் (Supply Chain) மீது 
அதிக கட்டுப்பாட்டைக் க�ொண்டிருக்கவும், 
மேலும் திறம்பட வர்த்தகம் செய்யவும் 
முடியும். இது உற்பத்தித் திறனை அதிகரித்து 
செயல்பாட்டுத் திறனை ஊக்குவிக்கிறது. 
இதன் பிற நன்மைகள் பின்வருமாறு.
●	 இறுதிப் பயனர்களுக்கு சேவையை 

மேம்படுத்துதல்
●	 உற்பத்தியை அதிகரித்தல்
●	 பிழைகள் குறைப்பு
●	 பதிலளிப்பு நேரங்களை குறைத்தல்
●	 தானியக்க செயல்பாடுகள் 
●	 செலவுகள் குறைப்பு
●	 அனைத்து த�ொழில் மற்றும் வர்த்தக 

கூட்டாளிகளை ஒருங்கிணைத்தல்
●	 செயல்பாட்டு நிலை பற்றிய தகவல் 

அளித்தல்
●	 நிதி விகிதங்கள் மேம்படுத்துதல்

18.4  EDI அடுக்குகள் (Layers)
மின்னணு தரவு பரிமாற்றக் கட்டமைப்பு 
நான்கு வெவ்வேறு அடுக்குகளைக் 
குறிப்பிடுகிறது.
●	 பயன்பாட்டு அடுக்கு (Semantic layer) 
●	 தரப்பாடுகள் அடுக்கு (Standard layer)
●	 இடமாற்று அடுக்கு (Transport layer)
●	 பரும அடுக்கு (Physical layer)
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ஆகும். மேலும் இந்த தரப்பாடுகளின் 
பராமரிப்பும் மேம்பாடும், ஐக்கிய நாடுகள் 
சபையின் ஐரோப்பாவிற்கான ப�ொருளாதார 
ஆணையத்துடன் (UNECE) இணைந்த 
ஐக்கிய நாடுகள் சபையின் வர்த்தக வசதி 
மற்றும் மின்னணு வர்த்தகத்திற்கான 
ப�ொருளாதார ஆணையம் (UN/CEFACT)  
மேற்கொண்டுள்ளது. 

EDIFACT

படம்: 18.4  UN/EDIFACT

EDIFACT க�ோப்பகம் (Directories)
EDIFACT பதிப்புகள் க�ோப்பகம் என்றும் 
அழைக்கப்படுகின்றன. EDIFACT 
க�ோப்பகத்தில் புதிய செய்திகளை சேர்க்க 
அல்லது புதுப்பிக்க ஏப்ரல் 1 ஆம் தேதி மற்றும் 
அக்டோபர் 1 ஆம் தேதி என வருடத்திற்கு 
இருமுறை திருத்தி அமைக்கப்படும். 
EDIFACT க�ோப்பகங்கள் D.18B ப�ோன்ற 
பெயர்களை க�ொண்டுள்ளன.

(D க�ோப்பகத்தை குறுக்கிறது. 18 
என்பது ஆண்டையும் A/B வெளியிடும் 
மாதத்தை குறிக்கிறது.)

EDIFACT துணைத்தொகுப்பு (Subsets)
சிக்கற்பாடு காரணமாக துறை சார்ந்த 
EDIFACT துணைத�ொகுப்புகள் 
உருவாக்கப்பட்டுள்ளன. EDIFACT ன் இந்த 
துணைத�ொகுப்புகள் குறிப்பிட்ட பயனர் 
குழுக்களுக்குரிய செயல்பாடுகளை மட்டுமே 
உள்ளடக்கியிருக்கும்.  எடுத்துக்காட்டு: 
CEFIC - இரசாயன த�ொழில்துறை

TDCC ஆகும். பின்னர் பிற த�ொழில்கள் 
அவற்றின் தனிப்பட்ட தேவைகளின் 
அடிப்படையில் தனித்துவமான தரங்களை 
உருவாக்கத் த�ொடங்கின. எ.கா. கிடங்கு 
த�ொழிலில் WINS.

சில ஆண்டுகளுக்குப் பிறகு 
ஐக்கிய நாடுகள் சபையின் ப�ொருளாதார 
ஆணையம் (UN / ECE / WP.4) சர்வதேச 
EDI தரங்களை மேம்படுத்துவதற்கான 
பணியை நடத்தியது. இரண்டு பெரிய 
பிராந்திய EDI தரங்களின் வளர்ச்சி 
மற்றும் ச�ோதனைக்குப் பின்னர், 
இரண்டு தரங்களும் ப�ொதுவான EDI 
தரங்களின் ஆராய்ச்சி மற்றும் வளர்ச்சியை 
ஒருங்கிணைத்து நடத்தத் த�ொடங்கின.  
1986 ஆம் ஆண்டில், UN / EDIFACT 
அதிகாரப்பூர்வமாக முன்மொழியப்பட்டது. 
மிகவும் பரவலாக பயன்படுத்தப்படுகிறது. 
EDI தரப்பாடுகள், ஐக்கிய நாடுகள் சபையின் 
UN/EDIFACT மற்றும் ANSI X12. 

18.7  UN/EDIFACT 
United Nations / Electronic Data 
Interchange for Administration, Commerce 
and Transport (UN / EDIFACT) ஐக்கிய 
நாடுகள் சபையின் மேற்பார்வையின் 
கீழ் உருவாக்கப்பட்ட ஒரு சர்வதேச EDI 
தரநிலை ஆகும். 1987 ல், UN/EDIFACT 
சர்வதேச தரப்படுத்தலுக்கான அமைப்பால் 
அங்கீகரிக்கப்பட்டது.  

இதில் சர்வதேச அளவில் 
ஒப்புக்கொண்ட தரப்பாடுகள், 
அட்டவணைகள் மற்றும் தற்சார்பு 
கணினி அமைப்புகளுக்கிடையே உள்ள 
கட்டமைக்கப்பட்ட தரவுகளின் மின்னணு 
பரிமாற்றத்திற்கான வழிகாட்டுதல்கள் 
ஆகியவை அடங்கும்.

இது வணிக பரிவர்த்தனைகளுக்கு 
சர்வதேச தரத்திலான பல்-த�ொழில்துறை, 
மின்னணு தரவு பரிமாற்ற தரப்பாடுகள் 
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EDIFACT தகவலும் தனித்த 6 பெரிய 
ஆங்கில எழுத்துக்களால் குறிப்பிடபடுகிறது. 
ஒரு EDIFACT தகவல் கூறு UNH ல் 
த�ொடங்கி UNT ல் முடிவடையும். EDIFACT 
தகவல் கூறுகளை சேவைத் தகவல்கள் 
மற்றும் தரவு பரிமாற்றம் என பிரிக்கலாம்.
●	 சேவைத் தகவல்கள்

	 ஒரு தகவலை உறுதிப்படுத்த / 
நிராகரிக்க, சேவைத் தகவல்கள் 
அனுப்பப்படும். 

எடுத்துக்காட்டு : 
❍	 CONTROL - ச�ொற்றொடரியல் 

சரிபார்ப்பு மற்றும் தகவலின் 
வருகையை உறுதிப்படுத்தல் 

❍	 APERAK - த�ொழில்நுட்ப பிழை 
செய்திகள் மற்றும் ஒப்புகை

●	 பரிமாற்ற தரவு 
சேவைத் தகவல்கள் தவிற பிற தகவல் 
கூறுகள் பரிமாற்ற தரவுகள் எனப்படும். 
எடுத்துக்காட்டு :

❍	 CREMUL - multiple credit advice
❍	 DELFOR - விநியோகத்திற்கு 

முந்தைய முன்னறிவிப்பு
❍	 IFTMBC - முன்பதிவு உறுதிப்படுத்தல்

EDIFACT கட்டமைப்பு (Structure)
EDIFACT ஒரு படிநிலை அமைப்பாகும். 
EDIFACT ன் மேல்நிலை அமைப்பு 
பரிமாற்றங்கள் என்று குறிப்பிடப்படுகிறது. 
பரிமாற்றங்களில் செயல்பாட்டு குழுக்கள்  
உள்ளன. செயல்பாட்டுக் குழுக்கள் பல 
பிரிவுகளை உள்ளடக்கிய தகவல்களைக் 
க�ொண்டுள்ளன. பிரிவுகள் கலப்பு 
கூறுகளால் ஆனது. இறுதிநிலை அமைப்பு 
ஒரு தரவு கூறு. 

EDI பரிமாற்றம் (Interchange)
பரிமாற்றங்கள் என்றும் உறை எனவும் 
அழைக்கப்படுகிறது. EDIFACT கட்டமைப்பின் 
உயர்மட்ட நிலை பரிமாற்றம் ஆகும். 
ஒரு பரிமாற்றம் பல தகவல் கூறுகளை 
க�ொண்டிருக்கக்கூடும். இது UNB ல் 
த�ொடங்கி UNZ உடன் முடிவடைகிறது.

EDIFACT தகவல் கூறு (Message)
EDIFACT இன் அடிப்படை தரநிலை 
கருத்து United Nations Standard Message 
- UNSM எனப்படும் சீரான தகவல் கூறுகள் 
ஆகும். துணைத்தொகுப்புகளில் துறையை 
ப�ொறுத்து தகவல் வகைகளின் பண்புகளை 
ஆழமாக குறிப்பிடப்படலாம். ஒவ்வொரு 

படம் 18.5  மாதிரி EDI பயன்பாடு
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எடுத்துக்காட்டு:
DTM + 11:200 606 200 730:203 ‘
EDIFACT ல் இந்த வரியை ஒரு பிரிவு 
என்கிற�ோம். ஒவ்வொரு குறியீட்டின் 
ப�ொருளும் வருமாறு:
●	 DTM என்பது பிரிவு அடையாளம் மற்றும் 

அது பின்வரும் தரவுகள் தேதி/நேரம் 
என்பதைக் குறிக்கிறது. 

●	 11 என்பது ஒரு தரவு கூறு. இந்த 
எடுத்துக்காட்டில், ஒரு தகுதியாக்கி 
எந்த வகையான நிகழ்வு என்பதை 
விவரிக்கிறது. குறியீடு 11 என்றால் 
ப�ொருட்கள் ஒப்படைப்பு நேரம்.

●	 200606200730 என்பது தரவு கூறு. 
இங்கு இது CCYYMMDDHHMM என்ற 
வடிவத்தில் தேதியைக் குறிக்கிறது.

●	 203 என்பது மற்றொரு தரவு கூறு. 
இது  தேதியின் வடிவத்தை குறிக்கும். 
இதன் ப�ொருள் (D.18B என்ற பதிப்பில்) 
தேதியின் வடிவம் CCYYMMDDHHMM, 
CC – நூற்றாண்டு, YY - ஆண்டு, MM 
- மாதம், DD – தேதி, HH – மணி, MM 
- நிமிடம்)

EDIFACT பிரிப்பான்கள்  (Separator)
பின்வரும் நிறுத்தற்குறிகள் EDIFACT தரவு 
பிரிப்பான்களாக  பயன்படுத்தப்படுகின்றன. 
எடுத்துக்காட்டு: UNA:+.? ‘

நிறுத்தற்குறி பயன்கள்

உடைமைக்குறி ’ பிரிவு முற்று

கூட்டல் குறி + பிரிவு குறிச்சொல் மற்றும் 
தரவு உறுப்பு பிரிப்பான்

முக்காற்புள்ளி : தரவுக் கூறு பிரிப்பான்

கேள்விக்குறி ? விடுவிப்பு குறி

முற்றுப்புள்ளி . தசமம் புள்ளி

EDIFACT பிரிவு (Segment)
EDIFACT பிரிவு என்பது தகவல் கூறின் 
பகுதியாகும். பிரிவுகள் ஒன்று அல்லது பல 
த�ொடர்புடைய பயனர் தரவு உறுப்புகளைக் 
க�ொண்டிருக்கலாம். 

பிரிவு அட்டவணை (Segment Tables)
பிரிவு அட்டவணை தகவல் கூறுகளின் 
பட்டியல் ஆகும். இதில் தகவல் கூறு 
பெயர், அதன் விளக்கம் Position, Tags, 
Tag Names, Requirements designator 
மற்றும் Repetitation ப�ோன்றவை 
பட்டியலிடப்பட்டிருக்கும். Requirements 
designator ஒரு தகவல் கூறு கட்டாயமா 
(M) அல்லது நிபந்தனையா (C) என்பதை 
குறிக்கும். (M) என்பது அந்த தகவல் கூறு 
ஒருமுறையேனும் கட்டாயமாக இடம்பெற 
வேண்டும் என்பதை குறிக்கும். (C) என்பது 
அந்த தகவல் கூறு தேவைப்படும் ப�ோது 
மட்டுமே பயன்படுத்தலாம் என்பதை 
குறிக்கும்.  எடுத்துக்காட்டு: C10 என்பது 
இந்த பிரிவு நிபந்தனையானது என்றும் 
0 முதல் 10 இடையே மடக்கிற்கான ஒரு 
எண்ணை குறிப்பிடலாம் என்பதையும் 
உணர்த்துகிறது. 

EDIFACT கூறுகள் (Elements)
EDIFACT கூறுகள் என்பது தரவுகளின் 
துணுக்கு ஆகும். இந்த தரவு உறுப்புகள் 
எளிமையாகவ�ோ அல்லது கலப்பு 
நிலையில் இருக்கலாம்.
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எடுத்துக்காட்டு: 

UNA:+.? ‘
UNB+IATB:1+6XPPC:ZZ+LHPPC:ZZ+940101:0950+1’
UNH+1+PAORES:93:1:IA’
MSG+1:45’
IFT+3+XYZCOMPANY AVAILABILITY’
ERC+A7V:1:AMD’
IFT+3+NO MORE FLIGHTS’
ODI’
TVL+240493:1000::1220+FRA+JFK+DL+400+C’
PDI++C:3+Y::3+F::1’
APD+74C:0:::6++++++6X’
TVL+240493:1740::2030+JFK+MIA+DL+081+C’
PDI++C:4’
APD+EM2:0:1630::6+++++++DA’
UNT+13+1’
UNZ+1+1’

நினைவில் க�ொள்க

●	 தேசிய தர நிர்ணய மற்றும் த�ொழில்நுட்ப நிறுவகத்தின் படி, EDI என்பது 
“பணக்கருவிகள் அல்லாத பிற த�ொழில் துறை ஆவணங்களை நேரடியாக இரு 
கணினிகளுக்கு இடையே, முற்றிலும் வடிவமைக்கப்பட்ட வடிவில் நடைபெறும் 
தவகல் பரிமாற்றம் ஆகும். 

●	 EDI என்பது “காகிதமற்ற வணிகம் “ மற்றும் EFT என்பது “காகிதமற்ற பண 
பரிமாற்றம்”.

●	 எட் கில்பெர்ட், EDI தந்தை என்று அழைக்கப்படுகிறார்.
●	 1985 இல், ஐக்கிய நாடுகள் சபை, மின்-வணிக த�ொழில்நுட்பம் உலகளாவிய 

நிலையில் த�ொழில் துறைக்கு உதவ EDIFACT யை உருவாக்கியது.
●	 நேரடி EDI புள்ளி-புள்ளி EDI என்றும் அழைக்கப்படுகிறது
●	 ஒவ்வொரு EDI தகவலும் ஆறு ஆங்கில எழுத்துகளை க�ொண்டதாக இருக்கும். 

285பாடம் 18  மின்னணு தரவு பரிமாற்றம்
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FTP ஒரு கணிப்பொறி பிணையத்தில் உள்ள முணையம் மற்றும் சேவையகத்திற்கு 
இடையே க�ோப்பு பரிமாற்றுவதற்கு ஒரு நிலையான பிணைய நெறிமுறை.

Interchange EDI படிநிலைசார் கட்டமைப்பின் மேல்மட்ட செய்தி

பிரிவு பிரிவுகள் ஒன்று அல்லது பல த�ொடர்புடைய பயனர் தரவு உறுப்புகள் 
க�ொண்டிருக்கும்.

பிரிப்பான்கள் தரவு அல்லது தரவு கூறுகளை பிரிக்க பயன்படுத்தப்படும் நிறுத்தக்குறிகள் 
குறிக்கிறது.

TDCC ப�ோக்குவரத்து தரவு த�ொடர்பாடல் குழு - முதல் த�ொழில்துறை EDI தரநிலை.

Telex ஒரு வகை த�ொலை அச்சியந்திரம்

VAN மதிப்புக் கூட்டப்பட்ட பிணையம், ஒரு மூன்றாம் தரப்பு 
பிணைய சேவை வழங்குநர்.

ANSI-ASC American National Standards Institute - Accredited Standards Committee

UN / EDIFACT United Nations / Electronic Data Interchange for Administration, Commerce and 
Transport 

பகுதி – அ 
	 I. 	� சரியான விடையைத் 

தேர்ந்தெடுத்து எழுதுக
1.	 EDI விரிவாக்கம்
	 அ) Electronic Details Information 
	 ஆ) Electronic Data Information
	 இ) Electronic Data Interchange
	 ஈ) Electronic Details Interchange
2.	 பின்வருவனவற்றில் வர்த்தகம், 

ப�ோக்குவரத்து, காப்பீடு, வங்கி 
மற்றும் சுங்க துறைகளில் தவகல் 
பரிமாற்றத்திற்கு என சர்வதேச 
அளவில் அங்கீகரிக்கப்பட்ட 
நிலையான வடிவமைப்பு எது?

	 அ) SSL	 ஆ) SET
	 இ) FTP	 ஈ) EDIFACT

3.	 முதல் த�ொழில்துறைக்கான EDI 
தரநிலை எது?  

	 அ) TDCC 	 ஆ) VISA 
	 இ) Master	 ஈ) ANSI
4.	 UNSM விரிவாக்கம் ____
	 அ) �Universal Natural Standard 

message
	 ஆ) �Universal Notations for Simple 

message
	 இ) United Nations Standard message
	 ஈ)  United Nations Service message 
5.	 பின்வருவனவற்றுள் எது EDI தரவு 

பரிமாற்ற வடிவம் அல்ல?
	 அ) VML	 ஆ) XML
	 இ) ANSI ASC X12 	 ஈ) TXT

வினாக்கள்

பாடம் 18  மின்னணு தரவு பரிமாற்றம்286
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பகுதி – ஆ 
II.	   �மூன்று வரிகளில் விடையளிக்கவும்  

1.	 EDI வரையறு
2.	 EDI மூலம் பரிமாற்றம் செய்யப்படும் 

சில வகை வணிக ஆவணங்களை 
பட்டியலிடுக.

3.	 EDI யின் நான்கு முக்கிய கூறுகள் 
எவை?

4.	 EDIFACT கோப்பகங்கள் என்றால் 
என்ன?

5.	 EDI துணைக்குழு பற்றி குறிப்பு 
வரைக.

பகுதி – இ 
III.  	� ஒரு பத்தியளவில் 

விடையளிக்கவும் 
1.	 VAN வழியாக EDI சிறுகுறிப்பு 

வரைக.
2.	 EDI அடுக்குகளைப் பட்டியலிடுக.
3.	 UN/EDIFACT பற்றி குறிப்பு வரைக.
4.	 EDIFACT செய்தி வகைகளை குறிப்பு 

வரைக.
5.	 EDI பிரிப்பான்கள் பற்றி எழுதுக. 

பகுதி – ஈ 
IV.	  �ஒரு பக்க அளவில் 

விடையளிக்கவும்
1.	 பல்வேறு வகையான EDI 

வகைகளை விளக்குக.
2.	 EDI நன்மைகள் யாவை?
3.	 EDIFACT அமைப்பு பற்றி எழுதுக.

6.	 EDI ன் தந்தை என்று 
அழைக்கப்படுபவர் யார்? 

	 அ) சார்லஸ் பாபேஜ் 
	 ஆ) எட் கில்பர்ட்
	 இ) பாஸ்கல்
	 ஈ) மேற்கூறிய எவரும் இல்லை
7.	 EDI அடிப்படை நியமங்கள்
	 அ) தரவுத் தரநிலை
	 ஆ) நெறிமுறைகள்
	 இ) (அ) மற்றும் (ஆ)
	 ஈ) (அ) மற்றும் (ஆ) இல்லை
8.	 EDIFACT விரிவாக்கம் 
	 அ) �EDI for Admissible  Commercial 

Transport
	 ஆ) �EDI for Advisory Committee and 

Transport
	 இ) �EDI for Administration, Commerce 

and Transport 
	 ஈ) �EDI for Admissible Commerce and 

Trade 
9.	 EDIFACT பதிப்புகள் ________ 

என்றும் அழைக்கப்படுகிறது. 
	 அ) செய்தி வகைகள்
	 ஆ) துணை த�ொகுதிகள்
	 இ) கோப்பகங்கள்
	 ஈ) க�ோப்புறைகள்
10.	ஒற்றை EDIFACT செய்திகளில் உள்ள 

எழுத்துக்களின் எண்ணிக்கை
	 அ) 5	 ஆ) 6	 இ) 4	 ஈ)3

மாணவர் நடவடிக்கை

●	 பல வகையான EDI தரநிலைகளை விளக்கும் விளக்கப்படத்தை தயாரிக்கவும். (எ.கா. 
வலை EDI)

287பாடம் 18  மின்னணு தரவு பரிமாற்றம்
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ேபஜ்ேமக்்கர் - ஆெைத்ணத ெடிெணமத்தல்

01
செய்முறை

வினா
 (a) ல�ஜ்லமக்கறரத் திைநது கீழ்க்கண்ட அளவுகளுடன் கூடிய ஒரு புதிய 

ஆவைத்றத உருவோக்கவும்.
  �க்க அளவு - A4
  �க்கங்களின் எண்ணிக்றக - 4
  லமல் �க்க ஓரம் 1.25 அங்கு�ம் மற்ை �க்கங்கள் 0.75 அங்கு�ம்

 (b) கீழ்க்கண்ட உறரறய உள்ளிடவும்.
  HAPPINESS
  Happiness is often confused with fun, good living, and riches. Sometimes fun is 

equated with happiness. Fun is what we experience while doing an activity, whereas 
happiness is a residual and long-lasting feeling. The path to happiness is long and full 
of challenges. Happiness requires life-long pursuit.

 (c) HAPPINESS என்னும் தற�பபிற்கு எழுத்து வறகயின் அளவு 18 புள்ளிகள், 
எழுத்து வறக Arial, தடிமன், றமய இறெவு ஆகிய வடிவூடடல்கறளச் செய்க.

 (d) �த்திக்கு கீழ்க்கண்ட வடிவூடடல்கறளச் செய்க.
  (a) Font   -  Arial
  (b) Font size - 12
  (c) Alignment  –  Justified
  (d) Leading  – 20   

  (e) ஆவைத்றத ‘happiness’  என்ை ச�யரில் லெமிக்க.  
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வசய்முணற
1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 

என்ை வரிறெயில் கிளிக் செய்து ஒரு புதிய ல�ஜ்லமக்கர் ஆவைத்றதத் திைக்கவும். 
�டத்தில் கோடடியுள்ளவோறு அலடோப ல�ஜ்லமக்கர் ென்ைல் திறர லதோன்றும்.

 ேநாக்்கம்
ல�ஜ்லமக்கறரத் திைநது சகோடுக்கப�டட அளவுகளுடன் கூடிய ஒரு புதிய ஆவைத்றத 
உருவோக்குதல்
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2. �டடிப�டறடயில் File > New என்�றதக் கிளிக் செய்யவும். (அல்�து) Ctrl + N என்னும் 
விறெப��றக குறுக்கு வழிறயப �யன்�டுத்தவும். இது Document Setup உறரயோடல் 
ச�டடிறயத் திைக்கும்.

� Page Size கீழிைங்கு �டடிபச�டடியில் கிளிக் செய்து A4 என்னும் �க்க அளறவத் 
லதர்நசதடுக்கவும்.

� Number of pages  உறரபச�டடியில் 4 எை உள்ளிடவும்.
� ஓரங்களின் அளறவ கீழ்க்கண்டவோறு மோற்ைவும்.
 Inside  – 0.75 inches
 Outside  – 0.75 inches
 Top – 1.25 inches
 Bottom – 0.75 inches
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3. OK  ச�ோத்தோறை கிளிக் செய்யவும். �டத்தில் கோடடியுள்ளவோறு Untitled – 1 என்ை 
ச�யரில் புதிய ஆவைம் திறரயில் லதோன்றும்.

4. சடக்ஸ்ட டூற�க் கிளிக் செய்து ஒரு உறரத்சதோகுதிறய உருவோக்கவும். பிைகு கீலழ 
சகோடுக்கப�டடுள்ள உறரறய தடடச்சு செய்யவும்.

 HAPPINESS
 Happiness is often confused with fun, good living, and riches. Sometimes fun is 

equated with happiness. Fun is what we experience while doing an activity, whereas 
happiness is a residual and long-lasting feeling. The path to happiness is long and full 
of challenges. Happiness requires life-long pursuit.
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5. சடக்ஸ்ட டூற�க் சகோண்டு ‘HAPPINESS’ என்�றதத் லதர்நசதடுக்கவும். Character 
Control Palette மூ�ம் எழுத்து வறக Arial, எழுத்து வறகயின் அளவு 18 புள்ளிகள், 
Leading  22 எை மோற்ைவும். Bold ச�ோத்தோறைக் கிளிக் செய்யவும். பிைகு றமய 
இறெவிற்கு Shift + Ctrl + C என்னும் ெோவி லெர்மோைத்றத அழுத்தவும். 
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6. சடக்ஸ்ட டூற�க் சகோண்டு �த்திறயத் லதர்நசதடுக்கவும். Character Control Palette 
மூ�ம் எழுத்து வறக Arial, எழுத்து வறகயின் அளவு 12 புள்ளிகள், Leading 20 எை 
மோற்ைவும். பிைகு லநர்த்தி இறெவிற்கு Shift + Ctrl + J என்னும் ெோவி லெர்மோைத்றத 
அழுத்தவும்.
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7. ஆவைத்றத ‘happiness’ என்ை ச�யரில் லெமிக்க
 விறெப��றகயில் Ctrl + S என்�றத அழுத்தவும் அல்�து �டடிப�டறடயில் File > 

Save என்�றதக் கிளிக் செய்யவும். Save publication உறரயோடல் ச�டடி லதோன்றும். 
File name உறரபச�டடியில் ‘happiness’ எை தடடச்சு செய்து Save ச�ோத்தோறைக் 
கிளிக் செய்யவும்.

வெளியீடு

HAPPINESS
Happiness is often confused with fun, good living, and riches. Sometimes fun is 

equated with happiness. Fun is what we experience while doing an activity, whereas 

happiness is a residual and long-lasting feeling. The path to happiness is long and 

full of challenges. Happiness requires life-long pursuit.

முடிவு
எதிர்�ோர்க்கப�டட முடிவு கிறடத்தது.
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ேபஜ்ேமக்்கர் - அறிவிப்புப் பலண்கணய 
உருொக்குதல்

02

வினா
ல�ஜ்லமக்கறரப �யன்�டுத்தி கீழ்க்கண்ட மோைவர் அறிவிபபுப ��றகறய உருவோக்கு.

 ேநாக்்கம்
ல�ஜ்லமக்கறரப �யன்�டுத்தி மோைவர் அறிவிபபுப ��றகறய உருவோக்குதல்.

வசய்முணற
1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0   

என்ை வரிறெயில் கிளிக் செய்து ஒரு புதிய ல�ஜ்லமக்கர் ஆவைத்றதத் திைக்கவும். 
2. �டடிப�டறடயில் File > New என்�றதக் கிளிக் செய்யவும். (அல்�து) Ctrl + N என்னும் 

விறெப��றக குறுக்கு வழிறயப �யன்�டுத்தவும். இது Document Setup உறரயோடல் 
ச�டடிறயத் திைக்கும்.

3. OK ச�ோத்தோறை கிளிக் செய்யவும். இபச�ோழுது Untitled – 1 என்ை ச�யரில் புதிய 
ஆவைம் திறரயில் லதோன்றும்.

4. சரக்டோங்கல் டூற�ப �யன்�டுத்தி 100 mm x 100 mm அளவுள்ள ச�டடிறய வறரய 
லவண்டும். அதில் சியோன் (Cyan) நிைத்றத நிரப�வும். tint மதிபற� 25 ெதவீதமோக 
மோற்ைவும். இபச�ோழுது ச�டடி கீழ்க்கண்டவோறு லதோன்றும்.

செய்முறை
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5. இலதல�ோன்று 100 mm x 15 mm அளவுள்ள மற்சைோரு ச�டடிறய வறரய லவண்டும். 
அதில் கருபபு (black) நிைத்றத நிரப�வும். இநதப ச�டடிறய சியோன் (Cyan) நிைம் 
நிரப�ப�டட ச�டடியின் லமல்�குதியில் றவக்கவும். இபச�ோழுது ச�டடி கீழ்க்கண்டவோறு 
லதோன்றும்.
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6. சடக்ஸ்ட டூற�க் கருபபு நிைப ச�டடியின் இடது ஓரத்திலிருநது வ�து ஓரம் வறர 
கிளிக் செய்து இழுக்க லவண்டும். பின்ைர் அதில் “ Student Notice Board” என்று 
தடடச்சு செய்ய லவண்டும்.

 எழுத்தின் நிைமும் ச�டடியின் நிைமும் ஒன்ைோக (கருப�ோக) இருக்கும். உறரறய 
தடடச்சு செய்து முடித்தவுடன் Ctrl + A  என்னும்  விறெப��றக குறுக்கு வழி மூ�ம் 
உறரறய லதர்நசதடுக்கவும்.

 Character Control palette மூ�ம் எழுத்தின் அளறவ 20 புள்ளிகளோக மோற்ைவும். Bold 
�ணிக்குறிறயக் கிளிக் செய்யவும். Reverse ச�ோத்தோறைக் கிளிக் செய்தோல் உறர 
சவள்றள நிைமோக மோறும். உறரறய றமய இறெவு செய்ய Shift + Ctrl + C என்னும் 
விறெப��றக குறுக்கு வழிறயப �யன்�டுத்தவும். இபச�ோழுது மோைவர் அறிவிபபுப 
��றக கீழ்க்கண்டவோறு திறரயில் லதோன்றும்.

வெளியீடு

முடிவு
எதிர்�ோர்க்கப�டட முடிவு கிறடத்தது.
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வினா
ல�ஜ்லமக்கறரப �யன்�டுத்தி கீழ்க்கண்ட விசிடடிங் கோர்றட உருவோக்கு.

 ேநாக்்கம்
ல�ஜ்லமக்கறரப �யன்�டுத்தி சகோடுக்கப�டடுள்ள விசிடடிங் கோர்றட உருவோக்குதல்.

வசய்முணற
 1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0   

என்ை வரிறெயில் கிளிக் செய்து ஒரு புதிய ல�ஜ்லமக்கர் ஆவைத்றதத் திைக்கவும். 
�டத்தில் கோடடியுள்ளவோறு அலடோப ல�ஜ்லமக்கர் ென்ைல் திறர லதோன்றும்.

ேபஜ்ேமக்்கர் - விசிட்டிங் ்கார்ணட உருொக்குதல்

03
செய்முறை
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2. �டடிப�டறடயில் File > New என்�றதக் கிளிக் செய்யவும். (அல்�து) Ctrl + N என்னும் 
விறெப��றக குறுக்கு வழிறயப �யன்�டுத்தவும். இது Document Setup உறரயோடல் 
ச�டடிறயத் திைக்கும்.
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3. OK  ச�ோத்தோறை கிளிக் செய்யவும். �டத்தில் கோடடியுள்ளவோறு Untitled – 1 என்ை 
ச�யரில் புதிய ஆவைம் திறரயில் லதோன்றும்.

4. இபச�ோழுது அளவீடுகறள Inches லிருநது Millimetersக்கு மோற்ைவும். 
 �டடிப�டறடயில் File > Preferences > general  என்ை கடடறளறயக் கிளிக் செய்யவும். 

(அல்�து) விறெப��றகயில் Ctrl + K என்�றத அழுத்தவும். இபச�ோழுது Preferences 
உறரயோடல் ச�டடி லதோன்றும்.

 அதில் Measurements மற்றும் Vertical ruler கீழிைங்கு �டடிபச�டடியில் Millimeters  
என்�றதத் லதர்நசதடுக்கவும்.
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5. கருவிப ச�டடியிலிருநது சரக்டோங்கல் டூற�த் லதர்நசதடுத்து செவ்வகம் வறரயவும்.
6. Control Palette இல் width  95 mm  எைவும் height  55 mm எைவும் மோற்ைவும்.  
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7. கருவிபச�டடியில் சடக்ஸ்ட டூற� கிளிக் செய்யவும். தடடச்சு செய்ய லவண்டிய 
உறரயின் எல்ற�றயக் குறிபபிட செவ்வகத்தின் இடது மூற�யிலிருநது வ�து 
மூற� வறர கிளிக் செய்து இழுக்கவும்.

8. ந�ரின் ச�யறர உள்ளிடடு, அறத சடக்ஸ்ட டூல் மூ�ம் லதர்நசதடுக்கவும். Control 
Palette மூ�ம் லதறவயோை எழுத்து வறக மற்றும் எழுத்தின் அளறவக் சகோடுக்கவும். 
பின்ைர் வ�து புைமோக சிறிது நகர்த்தவும்.
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9. �டிநிற� 7 ஐ மறு�டியும் செய்யவும். நிறுவைத்தின் ச�யறர உள்ளிடடு, அறத 
சடக்ஸ்ட டூல் மூ�ம் லதர்நசதடுக்கவும். Control Palette மூ�ம் லதறவயோை எழுத்து 
வறக மற்றும் எழுத்தின் அளறவக் சகோடுக்கவும். பின்ைர் வ�து புைமோக சிறிது 
நகர்த்தவும். முதல் எழுத்றத சடக்ஸ்ட டூல் மூ�ம் லதர்நசதடுத்து எழுத்து வறகயின் 
அளறவ ச�ரிதோக்கவும்.

z_XII CompApp_Tamil version Practicals.indd   304 21-04-2020   12:35:50



305வசய்முணற

10. �டிநிற� 7 ஐ மறு�டியும் செய்யவும். நிறுவைத்தின் முகவரிறய உள்ளிடடு, அறத 
சடக்ஸ்ட டூல் மூ�ம் லதர்நசதடுக்கவும். Control Palette மூ�ம் லதறவயோை எழுத்து 
வறக மற்றும் எழுத்தின் அளறவக் சகோடுக்கவும். பின்ைர் வ�து புைமோக சிறிது 
நகர்த்தவும்.

வெளியீடு

முடிவு
எதிர்�ோர்க்கப�டட முடிவு கிறடத்தது.
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வினா
ல�ஜ்லமக்கறரப �யன்�டுத்தி கீழ்க்கண்ட ல�பிறள (Label) உருவோக்கு.

 ேநாக்்கம்
ல�ஜ்லமக்கறரப �யன்�டுத்தி சகோடுக்கப�டடுள்ள ல�பிறள (Label) உருவோக்குதல்.

வசய்முணற
1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0   என்ை 

வரிறெயில் கிளிக் செய்து ஒரு புதிய ல�ஜ்லமக்கர் ஆவைத்றதத் திைக்கவும்.  
2. �டடிப�டறடயில் File > New என்�றதக் கிளிக் செய்யவும். (அல்�து) Ctrl + N என்னும் 

விறெப��றக குறுக்கு வழிறயப �யன்�டுத்தவும். இது Document Setup உறரயோடல் 
ச�டடிறயத் திைக்கும்.

3. OK  ச�ோத்தோறை கிளிக் செய்யவும். இபச�ோழுது Untitled – 1 என்ை ச�யரில் புதிய 
ஆவைம் திறரயில் லதோன்றும்.

ேபஜ்ேமக்்கர் - 
ஒரு ேலபிணள (Label) உருொக்குதல்

04
செய்முறை
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4. பிைகு அளவீடுகறள Inches லிருநது Millimeters க்கு மோற்ை லவண்டும். 
 �டடிப�டறடயில் File > Preferences > general  என்ை கடடறளறயக் கிளிக் செய்யவும். 

(அல்�து) விறெப��றகயில் Ctrl + K என்�றத அழுத்தவும். இபச�ோழுது Preferences 
உறரயோடல் ச�டடி லதோன்றும்.

அதில் Measurements மற்றும் Vertical ruler கீழிைங்கு �டடிபச�டடியில் Millimeters  என்�றதத் 
லதர்நசதடுக்கவும்.

5. கருவிபச�டடியிலிருநது சரக்டோங்கல் டூற�த் லதர்நசதடுத்து செவ்வகம் வறரயவும்.
6. Control Palette இல் width  100 mm எைவும் height  40 mm எைவும் மோற்ைவும்.  
7. �டடிப�டறடயில் Element > Rounded corners என்�றதக் கிளிக் செய்யவும்.
8. Rounded corners உறரயோடல் ச�டடியிலிருநது லதறவயோை வடிவத்றதத் 

லதர்நசதடுக்கவும். இபச�ோழுது வடடமுறை செவ்வகம் லதோன்றும்.
9. கருவிபச�டடியில் சடக்ஸ்ட டூற�க் கிளிக் செய்து, செவ்வகத்திற்குள் ஒரு 

உறரத்சதோகுதிறய உருவோக்கவும்.
10. Name : என்�றதத் தடடச்சு செய்து நுறழவு விறெறய அழுத்தவும்.
 STD :  என்�றதத் தடடச்சு செய்து நுறழவு விறெறய அழுத்தவும்.
 Section : என்�றதத் தடடச்சு செய்து நுறழவு விறெறய அழுத்தவும்.
 School : என்�றதத் தடடச்சு செய்து நுறழவு விறெறய அழுத்தவும்.
 Subject :  என்�றதத் தடடச்சு செய்து நுறழவு விறெறய அழுத்தவும்.
11. சடக்ஸ்ட டூற�க் சகோண்டு உறர முழுவறதயும் லதர்நசதடுக்கவும்.
12. �டடிப�டறடயில் Type > Indents / Tabs என்�றதக் கிளிக் செய்யவும். (அல்�து) 

விறெப��றகயில் Ctrl + I என்�றத அழுத்தவும். 
13. வ�து tab ஐ 90 mm அளவில் ச�ோருத்தவும்.  leader ச�ோத்தோறைக் கிளிக் செய்து வரும் 

�டடியலில் புள்ளிக்லகோடறடத் லதர்நசதடுக்கவும். பின்ைர் Apply ச�ோத்தோறைக் 
கிளிக் செய்யவும்.
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14. இபச�ோழுது லதறவயோை ல�பிள் உருவோக்கப�டடிருக்கும்.

வெளியீடு

முடிவு
எதிர்�ோர்க்கப�டட முடிவு கிறடத்தது.
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வசய்முணற
1. (MYSQL command prompt றய திைக்க) XAMPP control panel வழியோக
2. தரவுத்தளத்தில் உங்களுறடய �யைர் ச�யர் (user name) மற்றும் கடவுச்செோல்ற�ப 

(password) �யன்�டுத்தி உள்நுறழதல் 
3. சகோடுக்கப�டட  DDL MysQL விைோவற�யிறை செயல்�டுத்தி சவளியீடறடப ச�றுக.

SYNTAX: 
Based on the below syntax queries are built and executed.
* CREATE DATABASE testDB;
* CREATE TABLE table_name (column1datatype,column2datatype,column3datatype,   .... );
* ALTER TABLE `table_name` ADD COLUMN `column_name` `data_type`;
* DROP DATABASE databasename;
* SELECT * FROM TABLE NAME
* INSERT INTO table_name( field1, field2,...fieldN )   VALUES ( value1, value2,...valueN );
* UPDATE table_name SET field1 = new-value1, field2 = new-value2 [WHERE Clause]
* DROP TABLE table_name ;

1. CREATE -  தரவுத்தளம் மற்றும் அதன் ச�ோருடகறள உருவோக்குதல்  (table, index, 
views, store procedure, function, and triggers)

2. ALTER - ஏற்கைலவ இருக்கும் தரவுத்தளத்றத மோற்றியறமத்தல்.
3. DROP - தரவுத்தளத்தில் உள்ள ச�ோருறள நீக்குதல்.
4. SELECT - தரவுத்தளத்தில் ஒரு தகவற� திரும்� எடுத்தல்.
5. INSERT - தரறவ ஒரு அடடவறையில் லெர்த்தல். 
6. UPDATE - அடடவறையில் ஏற்கைலவ உள்ள தரறவ லமம்�டுத்துதல்
7. DELETE -  தரவுத்தள அடடவறையில் உள்ள அறைத்துத் தகவல்கறளயும் 

நீக்குதல்.

 ேநாக்்கம்
My sql ஐப �யன்�டுத்தி DDL மற்றும் DML விைவற�ச் செய�ோக்கல் 

MYSQL: தரவுத்தளத்தில் உள்ள 
்கட்டணள்களின் பயன்பாடு

05
செய்முறை
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நிரல்
CREATE DATABASE SchoolDB;

CREATE TABLE student(

studentID int,

LastName varchar(255),

FirstName varchar(255),

Address varchar(255),

City varchar(255) 

);

ALTER TABLE `members` ADD COLUMN `credit_card_number` VARCHAR(25);

DROP DATABASE SchoolDB

SELECT * FROM student

INSERT INTO student    (studentID ,LastName , FirstName,Address,City  )    VALUES

   (“002”, “Ram”,”Kumar”, “ROJA NAGAR”,”CHENNAI”);

SELECT * FROM student

UPDATE student SET LastName = ‘SRI’ WHERE studentID = 003;

SELECT * FROM student

DROP TABLE student ;

SELECT * FROM student

z_XII CompApp_Tamil version Practicals.indd   310 21-04-2020   12:35:50



311செய்முறை

வெளியீடு
Database created

Table created:

studentID LastName FirstName Address City

Table Altered

Database dropped

StudentID LastName FirstName Address City

101 C Priya 1, new street Trichy

202 S Ramu 5, North garden St Madurai

One row inserted.

StudentID LastName FirstName Address City

101 C Priya 1, new street Trichy

202 S Ramu 5, North garden St Madurai

002 Ram Kumar ROJA NAGAR CHENNAI

003 R Krishna Park Street Coimbatore

StudentID LastName FirstName Address City

101 C Priya 1, new street Trichy

202 S Ramu 5, North garden St Madurai

002 Ram Kumar ROJA NAGAR CHENNAI

003 SRI Krishna Park Street Coimbatore

Table dropped.

Table not found.
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வசய்முணற 
1. Xampp Server (Apache) துவங்குதல்.
2. Goto நிகர் லகோபபுறைக்கு செல்லுதல் (Virtual path folder) (c:\xampp\ntdoc)
3. test.php file லகோபபிறை உருவோக்கி, நிரற� தடடச்ெ செய்க.
4. (http://local host/test.php) என்ை �டடற� �யன்�டுத்தி உங்கள் வற� உ�ோவியில் 

(web browser)நிரற� இயக்கவும்.

நிரல்
<html>
<body>
<?php
echo “Welcome to  Our School”;
$color = “blue”;
echo “My car is “ . $color . «<br>”;

echo “My dress is “ . $COLOR . «<br>”;

echo “My box is “ . $coLOR . «<br>”;

// test whether a number is greater than 30, 20 or 10 using ternary operator
functiontrinary_Test($n){
$r = $n > 30
? “greater than 30”
: ($n > 20
? “greater than 20”
: ($n >10
? “greater than 10”

 ேநாக்்கம்
அடிப�றடPHP நிரற� உருவோக்கி சவளியீடறட ச�றுதல்.

PHP – அடிப்பணட நிரல்

06
செய்முறை
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: “Input a number atleast greater than 10!”)); 
echo $n.” : “.$r.”\n”;
}
trinary_Test(32);
trinary_Test(21);
trinary_Test(12);
trinary_Test(4);
 ?>

</body>

</html>

வெளியீடு

Welcome to  Our School

My car is blue
My dress is
My box is

32 : greater than 30                                        
21 : greater than 20                                        
12 : greater than 10                                        
4 : Input a number atleast greater than 10!
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PHP – மாறி்கணள உருொக்கி இயக்குதல்

07
செய்முறை

வசய்முணற
1. நிகர் லகோபபுறைக்கு செல் (Virtual path folder) (c:\xampp\ntdoc)
2. Variable.php லகோபபிறை உருவோக்கி நிரற� தடடச்சு செய்க.
3. (http://local host/variable.php) என்ை  URL றய �யன்�டுத்தி உங்கள் வற� 

உ�ோவியில் (web browser) நிரற� இயக்கவும். 
நிரல்
<html>
<body>
<?php
$a = 25; // Numerical variable
$b = “Hello”; // String variable
 $c = 5.7; // Float variable
echo ‚Number is : “.$a.‚<br/>”;
echo ‚String is : “.$b.‚<br/>”;
echo “Float value : “.$c;
$txt = “INDIA”;
echo “I love $txt!”;
$x = 2;
$y = 2;
echo $x + $y;
function demo() {
        echo «<p>Variable x inside function is: $x</p>»;
}  
demo();

 ேநாக்்கம்
Xampp server (Apache) றய சதோடங்கு
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echo “<p>Variable x outside function is: $x</p>”;
function myTest() {
    static $a = 0;
    echo $a;
    $a++;
}
 
myTest();
echo “<br>”;
myTest();
echo “<br>”;
myTest();
 ?>
</body>
<html>

வெளியீடு

Number is : 25 
String is : Hello 
Float value : 5.7
I LOVE INDIA
4
0
1
2
Variable x inside function is:
Variable x outside function is: 2
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ECHO மற்றும்  PRINT 
அறிக்ண்கணய உருொக்கி இயக்குதல்.

08
செய்முறை

 ேநாக்்கம்
PHP நிரலில்  ECHO மற்றும்  PRINT அறிக்றகறய உருவோக்கி இயக்குதல்.

வசய்முணற

1. Xampp Server றய சதோடங்கு 
2. நிகர் லகோபபுறைக்கு செல்லு (Virtual path folder) (c:\xampp\htdocs)
3. echo-print.php  லகோபபிறை உருவோக்கி, நிரற� தடடச்சு செய்க.
4 (http://local host/function.php) என்ை URL றய �யன்�டுத்தி உங்களின் வற� 

உ�ோவியில்  (web browser) நிரற� இயக்கவும். 

நிரல்
<html>

<body>

<?php

//Use Echo 

echo “Welcome to Tamilnadu<br>”;

 // Use ‘print’ to print on console

print “Welcome to our School!<br>***********”;
$txt1 = “Learn PHP”;
$txt2 = “Daily”;
$x = 5;
$y = 4;
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echo “<h2>” . $txt1 . «</h2>»;
echo “Study PHP “ . $txt2 . «<br>”;
echo $x + $y;
$txt3 = “Hello”;
$txt4 = “Welcome”;
$x = 7;
$y = 3;

print “<h2>” . $txt3 . «</h2>»;
print “Hi “ . $txt4 . «<br>”;
print $x + $y;
?>
</body>

</html>

வெளியீடு

Welcome to Tamilnadu

Welcome to our School!

***********

Learn PHP
Study PHP  Daily
9

HELLO
Hi Welcome
10
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வசய்முணற
1. Xampp serverறய சதோடங்குதல் 
2. நிகர் லகோபபுறைக்கு செல் (c:\xampp\htdocs)
3. function.php  லகோபற� உருவோக்கி, நிரற� தடடச்சு செய்க.
4. (http://local host/function.php) என்ை URLறய �யன்�டுத்தி உங்களின் 

வற�உ�ோவியில்  (web browser) நிரற� இயக்கவும்.

(http://localhost/ funtion.php)
<html>
<body>
<?php
// Displays the length of the string
echostrlen(“Hello world!”);
//Counting number of words in a String
echo str_word_count(“Good Morning All”);
// Reversing a string
echo strrev(“welcome”);
// calculates position of strong
echo strpos(“Hello world!”, “world”);

ECHO மற்றும்  PRINT 
அறிக்ண்கணய உருொக்கி இயக்குதல்.

09
செய்முறை

 ேநாக்்கம்
PHP யில் ெரங்களின் செயற்கூறிறை உருவோக்கி இயக்குதல்.
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319செய்முறை

// replacing the text
echo str_replace(“Hi”, “Hello”, “Hi Everyone”);
define(“GREETING”, “Good Morning!!!”);
echo GREETING;
// changes the color of the first character of a word

$text = ‘PHP Tutorial’;
$text = preg_replace(‘/(\b[a-z])/i’,’<span style=”color:red;”>\1</span>’,$text);
echo $text;
?>

</body>

</html>

வெளியீடு

12

3

emoclew

6

Hello Everyone

Good Morning!!!

PHP Tutorial
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வசய்முணற
1. Xampp server றய சதோடங்கு
2. நிகர் லகோபபுறைக்கு செல் (virtual path folder) (c:\xampp\htdocs)
3. Convert.php லகோபற� உருவோக்கி நிரற� தடடச்சு செய்க. 
4. (http://local host/ convert.php) என்ை URLறய �யன்�டுத்தி உங்களின் வற� 

உ�ோவியில் (web browser) நிரற� இயக்கவும்.

(http://localhost/convert.php)
<html>
<body>
<?php
functionword_digit($word) {
    $warr = explode(‘;’,$word);
    $result = ‘’;
foreach($warr as $value){
switch(trim($value)){
case ‘zero’:
                $result .= ‘0’;
break;
case ‘one’:
                $result .= ‘1’;
break;
case ‘two’:
                $result .= ‘2’;
break;

எழுத்ணத எண்ைா்க மாற்றுதல்

10
செய்முறை

 ேநாக்்கம்
PHP  ல் எழுத்றத எண்ைோக மோற்றுவதற்கோை நிரல்.
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case ‘three’:
                $result .= ‘3’;
break;
case ‘four’:
                $result .= ‘4’;
break;
case ‘five’:
                $result .= ‘5’;
break;
case ‘six’:
                $result .= ‘6’;
break;
case ‘seven’:
                $result .= ‘7’;
break;
case ‘eight’:
                $result .= ‘8’;
break;
case ‘nine’:
                $result .= ‘9’;
break;    
        }
    }
return $result;
}

echoword_digit(“zero;three;five;six;eight;one”).”\n”;
echoword_digit(“seven;zero;one”).”\n”;
?>
</body>
</html>

வெளியீடு

035681                                                                 
701
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கல்வி ஆல�ோசகர்
முனைவர் ப�ொன். குமார்
இணை இயக்குனர் ( பாடத்திட்டம் )
மாநிலக் கல்வியியல் ஆரய்ச்சி மற்றும் பயிற்சி நிறுவனம்,
சென்னை - 600 006

பாட ஒருங்கிணைப்பாளர்
உ. ஆர்த்தி
பட்டதாரி ஆசிரியை,
அரசு மகளிர் மேல்நிலைப்பள்ளி,
மதுராந்தகம், காஞ்சிபுரம்.

புத்தக வடிவமைப்பாளர்
ஆர�ோக்கியம் பெலிக்ஸ்
பிளாக்பெர்ட் வடிவம் மற்றும் பிரிண்ட்ஸ்,
சென்னை.

தர கட்டுப்பாடு
அருண் காமராஜ் பழனிசாமி
டேனியல்
ய�ோகேஷ் ப.

தட்டச்சர்
இரா. ம�ோகானாம்பாள்
வேளச்சேரி, சென்னை.

அட்டை வடிவமைப்பாளர்
கதிர் ஆறுமுகம்
சென்னை.

விரைவுக் குறியீட்டு மேலாண்மைக் குழு
இரா. ஜெகநாதன், இடைநிலைஆசிரியர், 
ஊராட்சிஒன்றியநடுநிலைப்பள்ளி, கணேசபுரம், ப�ோளூர், 
திருவண்ணாமலை.

ஆ.தேவி ஜெஸிந்தா, பட்டதாரிஆசிரியர்,
அரசினர்உயர்நிலைப்பள்ளி, என்.எம்.க�ோவில், வேலூர்.

மு.சரவணன், பட்டதாரிஆசிரியர்,
அரசினர்மகளிர்மேனிலைப்பள்ளி, 
வாழப்பாடி, சேலம்.

ஒருங்கிணைப்பு
ரமேஷ் முனிசாமி

பாடநூல் வல்லுநர்கள்
திருமதி. பாக்கியலட்சுமி
உதவி பேராசிரியர் மற்றும் துறைத்தலைவர்  
கணினி பயன்பாடுகள் துறை,
குயின் மேரிஸ் கல்லூரி, சென்னை,

திரு. அமுதன்
உதவி பேராசிரியர் மற்றும் இணை புல முதல்வர்
பாண்டிச்சேரி ப�ொறியியல் கல்லூரி, பிள்ளைச்சாவடி,
பாண்டிச்சேரி.

பாட மேலாய்வாளர்கள்
திரு. சரவணன்
துணை இயக்குநர்,
அப்பல�ோ கலை மற்றும் அறிவியல் கல்லூரி, சென்னை.

திரு. எம். முரளி
த�ொழில்நுட்ப ஆல�ோசகர்,
காக்னிசென்ட் டெக்னாலஜி,
துரைப்பாக்கம், சென்னை.

ம�ொழிபெயர்ப்பாளர்கள்
இராணி வேளாங்கன்னி
ஜெய்கோபால் கர�ோடியா
அரசு பெண்கள் மேல்நிலைப்பள்ளி
நங்கநல்லூர், சென்னை.

C. ஸ்ரீதேவி
அரசு முன் மாதிரி மேல்நிலைப்பள்ளி
திருவல்லிக்கேணி, ச�ொன்னை – 5.

K.V. மஞ்சுளா
சென்னை மேல்நிலைப்பள்ளி,
சூளைமேடு, சென்னை.

A. G. கலைவாணி
சென்னை பெண்கள் மேல்நிலைப்பள்ளி,
பெரம்பூர், சென்னை – 11.

T. முருகாம்பாள்
முதுகலை ஆசிரியை,
அரசு மேல்நிலைப்பள்ளி,
ச�ோமராசன்பேட்டை, திருச்சி.

ஆங்கிலவழி பாட நூல் ஆசிரியர்கள்
திருமதி. சுபாஷினி
பேராசிரியை & துறைத்தலைவர்,
தகவல் த�ொழில்நுட்பத் துறை,
சத்யபாமா அறிவியல் & த�ொழில்நுட்ப நிறுவனம்,
சென்னை.

திருமதி. A. ஆர்த்தி
இணை பேராசிரியை,
தகவல் த�ொழில்நுட்பத் துறை,
RMK ப�ொறியியல் கல்லூரி,
கவரைப்பேட்டை, திருவள்ளூர்.

திருமதி. சந்தியா அழகர்சாமி
துணை பேராசிரியை,
தகவல் த�ொழில்நுட்பத் துறை,
ஜேப்பியார் SRR ப�ொறியியல் கல்லூரி,
சென்னை.

திரு. R. சேதுராமன்
துணை பேராசிரியர்,
கணினி அறிவியல் & ப�ொறியியல் துறை,
சத்யபாமா அறிவியல் & த�ொழில்நுட்ப நிறுவனம்,
சென்னை.

திரு. எம். சிவக்குமார்
அரசு மேல்நிலைப்பள்ளி,
சிறுகாம்பூர், திருச்சி.

திரு. எஸ். வெங்கடாச்சலபெருமாள்
அரசு மேல்நிலைப்பள்ளி, மானூர், திருநெல்வேலி.

திரு. ஜி. சுரேஷ்குமார்
அரசு ஆண்கள் மேல்நிலைப்பள்ளி,
திருமங்கலம், மதுரை.

திரு. எம்.கணேஷ்
அரசு பெண்கள் மேல்நிலைப்பள்ளி,
மாத்தூர், கிருஷ்ணகிரி.

திரு. ஜெ.சுந்தர்
அரசு மேல்நிலைப்பள்ளி,
க�ொசவன்புதூர், வேலூர்.

A. சங்கீதா
அரசு மேல்நிலைப்பள்ளி,
இராஜன்தாங்கல், திருவண்ணாமலை.

கணினி பயன்பாடுகள் - மேல்நிலை இரண்டாம் ஆண்டு
நூலாசிரியர்கள் மற்றும் மேலாய்வாளர்கள்

இந்நூல் 80 ஜி.எஸ்.எம். எலிகண்ட் மேப்லித்தோ தாளில் 
அச்சிடப்பட்டுள்ளது. ஆப்செட் முறையில் அச்சிட்டோர்:
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